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They are only intended to pro-vide support for typical applications. You
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equipment. When using these application examples, you recognize that
Siemens cannot be made liable for any damage/claims beyond the
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deviations between the recommendations provided in these application
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contents of the other documents have priority.
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Foreword

Objective of the application
This application was created to provide the user with the following:

e A modifiable and expandable example of an industrial temperature
measurement and

o the illustration of a convenient option of operating and visualizing a
control using a touch panel.

This application shows how using a SIMATIC controller, a PT100 resistivity
thermometer and a SITRANS TK-L measuring transducer the temperature
of a medium is determined and actions are performed depending on
defined temperature levels.

e This topic is particularly relevant in the chemical industry as well as the
beverage industry.

Main contents of this application
The following main points are discussed in this application:

V20_e.doc

e Layout, functionality and application of resistivity thermometers,
e STEP7 program for temperature measurement in a production process

e Connecting a touch panel for process control and plant monitoring using
WinCC flexible.

peraturmessung,
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This application does not include a description of

o the SIMATIC STEP 7 engineering tool,
e the WInCC flexible visualization software.

Basic knowledge of these topics is required.

V2.0 07/03/06 3/54



SI EM ENS Foreword

Application Resistivity Thermometer ID Number: 23541638

Structure of the document
The documentation of this application is divided into the following main

parts.
Part Description

Application Description Provides a general overview of the contents. You
will learn about the components used (standard
hardware and software components and the
specially created software).

Function Principles and This part describes the detailed function processes

Program Structures of the involved hardware and software components,

the solution structures and — where useful — the
specific implementation of this application. This part
is necessary if you want to learn about the
interaction of the solution components, for example
in order to use them as the basis for own
development.

Structure, Configuration This part leads you step by step through the

8 and Operation of the structure, important configuration steps,
g‘ Application commissioning and operation of the application.
d Appendix In this chapter you will find further information on

e.g. literature, glossary etc.

peraturmessung,
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This entry originates from the internet application portal of the A&D Service
and Support. It has the entry ID 23541638. The direct link to the download
page of this entry is available in /2/.
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Application Description

Content
You are provided with a general overview of the contents. You will learn
about the components used (standard hardware and software components
and the specially created software).
The displayed performance data illustrate the performance capability of this
application.

1 Automation Task

Here you find information on ...
the automation task discussed in the documentation on hand.

1.1 Overview

Introduction

During mixing processes it is necessary to acquire the temperature of a lye,
a bath an ingredient or the basic liquid for the purpose of...

e Ensuring an ideal and constant working temperature within a process
step,

e detecting the permissible minimum / maximum temperature of a
medium,

e determining temperatures for visualizing them or for triggering various
actions in the production process

in a reliable way with suitable means that meet the respective process
requirements. On a PLC these measuring data are used to control the
technical process or for monitoring purposes. An HMI (human machine
interface, e.g. a touch panel) enables visual monitoring of temperature
values and defining new rated or limit temperature values.

Overview of the automation task

The below figure shows an example of a possible field of application for this
application.

V2.0 07/03/06 6/54
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Figure 1-1: Bottle cleaning in the beverage industry

(_resistivity thermometer )

pre-soak 1 pre-soak 2 pre-soak 3 main lye

Description of the automation task

The temperature of the main lye is to be measured with the resistivity
thermometer. Automatic actions are to be started depending on certain
temperatures of the main lye. These actions are to ...

e inform personnel when the temperature of the main lye is 5°C below a
set point value.

¢ reduce the velocity of the bottle transportation if the temperature of the
main lye is 6 °C below a set point value.

e stop the process completely if the temperature of the main lye is 8 C
below a set point value.

The above actions are represented in the application by the setting of
digital outputs and in software terms by jumping to program parts where a
respective user defined action can be programmed.

Temperature recording

A low pressure screw-in resistivity thermometer with PT 100 measuring
resistance is used as temperature sensor. The resistivity thermometer is
connected to an analogue input of the controller via a measuring
transducer, which supplies a current of 4mA...20mA that is proportional to
the temperature.

To meet your requirements, the resistivity thermometer is amongst others
available in the following versions.

e With one or two measuring resistances,

¢ in different lengths,

e with or without neck tube,

¢ with or without explosion protection,

e with or without integration option for the measuring transducer.

V2.0 07/03/06 7/54
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See chapter 2.4 for performance data of the thermometer and the
measuring transducer.

1.2 Requirements

This application is realized in a STEP7 project. It is to meet the
requirements listed below:

Sensor requirements

The temperature of a liquid shall be acquired with a thermometer.

The encoder is to be designed as screw-in PT100 resistivity
thermometer (in accordance with DIN 43765) with measuring
transducer.

The encoder shall be capable to detect a temperature range of
10...100 C and to image it onto an analogue signal of 4...20mA by
means of the measuring transducer.

The thermometer has a protective tube of stainless steel.

Controller requirements

The controller shall calculate the temperature of the liquid in degrees
Celsius using the signal from the measuring transducer.

The controller shall divide the permissible, user defined overall
temperature range into seven sections which each have one digital
output (Q 4.0...Q 4.6) assigned to. The DO with the temperature
section of the current temperature value is controlled. It should be easy
for the user to change the temperature section.

Underrun or overrun of the lower or upper temperature limit of the
overall temperature range should be indicated by a blinking digital
output (e.g. for connecting a signal lamp). The blinking should require
acknowledgement.

The respectively last limit temperature violation is to be logged by the
time stamp of the CPU. If there has been no temperature violation since
the start of the CPU, the time stamp of the startup shall be logged.

HMI requirements

The HMI is to be realized by a touch panel (screen diagonal 6 inches).
The following information is to be displayed:
- Current temperature of the liquid (bar-type display and value),

- violation of the temperature limits (minimum and maximum
temperature, display by blinking marks),

- date and time of the last limit temperature violation,

- current temperature with regard to the user defined temperature
sections (graphically by marks).

V2.0
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e The following operations are to be possible:

Input/modification of the temperature section limits,
acknowledging of the limit temperature violations
switching of the language English«—German

terminating the runtime

Note The above-mentioned requirements are met by the application software
without need for additional programming overhead or entering
parameters in data blocks.

V2.0
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2 Automation Solution

Here you find information on ...
the solution selected for the automation task.

2.1 Overview of the overall solution

Display

The following figure displays the most important components of the
solution:

Figure 2-1: Hardware overview of the automation solution

Visualization / Operation Logic Control

SIEMERS

Temgeraturanzeige

e ) e |
0
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Structure

A SIMATIC CPU 314C-2 DP is the key element of the application. This
central processing unit already includes the digital and analog inputs and
outputs required by the application. The switching output of the measuring
transducer is directly connected to the analog input integrated in the central
processing unit. The TP170A touch panel is connected to the MPI of the
controller via a PROFIBUS cable. All components of the application are
supplied with 24V DC by the power supply PS 307.

Description of the core functionality

Overview and description of the user interface

A TP 170A touch panel is used as HMI. The display/HMI is realized as
three screens:

e Display Temperature (start picture)

o Define Temperatures

e Temperature Violations

The release of the temperature recording and the acknowledgement of a
limit temperature violation are realized via digital inputs.

The user-defined area with the current temperature, as well as temperature
limit violations, are additionally signaled to the touch panel display by digital
output bits.

V2.0
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TP 170A — “Display Temperature” screen (start picture)

Figure 2-2: Display Temperature (start picture)
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| SIMATIC PANEL |

Display Temperature

Temperature [°C]: | +67.12

100

Lask
Temp, Yiolation

N

Acknowledge |

10

Define Temp.

e ————

Stop Runkirne

—

Provided that the touch panel has already been loaded with the HMI
software created in WinCC flexible, the above start screen — which is to be
considered the main screen — is displayed when applying the supply

voltage. The screen contains the following elements:

1.

Display of temperature

It is displayed as a °C value as well as a bar diagram (range
10...100°C). The calculation and display of the current temperature is
only performed if it has been enabled via input | 0.0. At 1 0.0 = 0 the last
recorded temperature value is displayed. Outside the range
(temperature <10°C, >100°C), parameterized at the measuring
transducer, the respective extreme values 10°C or 100°C will be
displayed.

Display and acknowledgement of limit temperature violations
A limit temperature violation occurs if the following limit values specified
in DB10 are violated:

- Temperature too low
T_comp [1] (default value 20°C)

- Temperature too high
T _comp [8] (default value 90°C)

A temperature too low or too high is indicated by two blinking marks on
the right side of the bar diagram ( . w ). If the temperature is outside
the permitted limits, the blinking marks are invisible. A limit temperature

V2.0
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violation requires acknowledgement. The respective blinking mark only
disappears if the temperature is within the permitted range and the
alarm has been reset with the “Acknowledge” button. Limit values can
be changed in the “Define Temperatures” screen.

3. “Last Temp. Violation” button
This button takes you to the “Temperature Violations” screen. This
screen displays the time stamp of the last insufficient or excess
temperature.

4. “Define Temp” button
This button takes you to the “Define Temperatures” screen. There you
can specify eight temperatures for process control or display purposes.

5. Switching of the user interface language
With this button you can switch between the languages English and
German. By default, the setting is on English and the button is labeled
“German”. In case of German user interface language, the button is
labeled “English”.

6. Stopping Runtime
The button “Stop Runtime” terminates the Runtime in order to reload
the touch panel, for example.

TP 170A — “Define Temperatures” screen

Figure 2-3: Define Temperatures

| SIMATIC PANEL |

; Define Temperatures

Temperature 8 [9C] 490,00 fuppet limit)

Temperature 7 [ 9]
Temperature 6 [ 9]
Temperature 5 [ 9]
Temperature 4 [ 9]
Temperature 3 [ 9]
Temperature 2 [ 9]
Temperature 1 [ 9]

1 4

+a0.00
+70.00
+60.00
+50,00
+40.00
+30.00
+20.00

4

{loweer limit)
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The “Define Temp.” button in the “Display Temperature” screen takes you
to the “Define Temperatures” screen. Here you specify the discrete filling
levels which you can use for process control or display purposes.

1. Entering the temperature values
If you are using the example project, the values from TP 170A — “Define
Temperatures” screen

2. are already entered as reference temperature values. When selecting
(touching) the respective gray-shaded 1/0 box, a numerical keyboard is
displayed on the screen with which you can enter the desired value and
apply it using the Enter key. All temperatures have to be within the
measuring range, which has been specified by means of the
configuration software SIPROM TK of the measuring transducer (in the
application example 10...100°C). The input value is rounded to two
decimals. “Temperature” corresponds to the lowest, “Temperature 8" to
the highest definable temperatures. For the input, the following must
apply:Temperature n < temperature n+1 (n=1...7)

The falling below Temperature 1 (insufficient temperature) or the
exceeding of Temperature 8 (excess temperature) releases the limit
temperature violation which must be acknowledged.

3. Display of the current temperature range
The area between defined, neighboring comparison temperatures, in
which the current temperature value is located, is displayed by a mark
(" 4) on the right next to the input fields for the temperature.

4. Display of temperature violations
Temperature violations requiring acknowledgement in this screen are,
analog to the “Display Temperatur” screen, also displayed as blinking
marks (( a = ).

Use the “Back” button located at the bottom of the display to return to the
“Display Temperature” screen.

V2.0
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TP 170A — “Temperature Violations” screen

Figure 2-4: Temperature Violations

[SIMATIC PANEL

; Temperature Violations

Last Festart
5/12/2006 10:03:34 AM

Last Crerrun

5/12/2006 3:38:11 PM

|
|
|

The “Last Temp.Violation” button in the “Display Temperature” screen takes
you to the “Temperature Violations” screen.

1. Display in the upper frame

- If since the last restart of the CPU no insufficient temperature has
taken place, then the time stamp of the last restart is displayed.

- If since the last restart of the CPU at least one insufficient
temperature has been detected, the time stamp of the last falling
below the minimum temperature is displayed.

2. Display in the bottom frame

- If since the last restart of the CPU no excess temperature has taken
place, then the time stamp of the last restart is displayed.

- If since the last restart of the CPU at least one excess temperature
has been detected, the time stamp of the last exceeding of the
maximum temperature is displayed.

Use the “Back” button located at the bottom of the display to return to the
“Display Temperature” screen.
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Table 2-1
Input Meaning Note
0.0 Release of the temperature recording
(released = 1)
Acknowledging of a limit temperature Identical with the “Acknowledge”
10.1 violation button in the “Display Temperature”

(Acknowledging = edge 0>1)

screen

Digital output bit

Table 2-2
Output Meaning Note
Q4.0 Temperature measuring value between
' temperature 1 and 2
041 Temperature measuring value between These output bits correspond to the
) temperature 2 and 3 position of the display mark ( 4 ) in
: the “Define Temperatures” screen
Temperature measuring value between
Q4.2 temperature 3 and 4 at the touch panel.
Q43 Temperature measuring value between
) temperature 4 and 5
Q44 Temperature measuring value between
' temperature 5 and 6
Q45 Temperature measuring value between
) temperature 6 and 7
046 Temperature measuring value between
’ temperature 7 and 8
. . - The function is identical with the
There is an insufficient or excess temperature. o .
o : blinking marks (4~ ¥ )in the
The output is blinking. Resetting the output iy " P
Q5.0 o Display Temperature” and “Define
occurs by acknowledgment of the limit B
o Temperatures” screens at the touch
temperature violation.
panel.
051 There is an insufficient temperature:
' The measuring value is below temperature 1
Q5.2 There is an excess temperature:
' The measuring value is above temperature 8
2.2.2 Process sequence of the main functionality
The following flowchart illustrates main functionality “Temperature
Recording”. The process is realized in function FC12.
V2.0 07/03/06 16/54
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Figure 2-5: Flowchart of the core functionality

temperature detection enabled? n
(10.0=1?)

vy end

calculate current temperature [°C]
from measuring transducer [4...20mA];

v

reset all Q 4.n (n=0..6)
delete all level tags'| 4 ;

v

category temperature violation?

insufficient temperature excess temperature n

reset Q 5.1, Q 5.2;

‘set ALAR O EI: ‘ ‘SEt AL YR ‘ identify and set that output Q 4.n (n=0..6),
which corresponds with the current
changeover display changeover display temperature range;
,Last Restart" — ,Last Restart* — display corresponding temperature tag* 4 ;
— ,Last Underrun; — ,Last Overrun; 3
enter current time stamp for enter current time stamp for
displaying ,Last Underrun“ into displaying ,Last Overrun“ into
DB10; DB10;
[ [
v

limit temperature violation acknowledged?*
vy

still insufficient temperature? y
(Q5.1=1?)

vn

reset ALARM_LOW_TEMP;

:

still excess temperature?
(Q5.2=1?)

L

reset ALARM_HIGH_TEMP;

ple
)

make blinking tag® ¥  from ALARM_LOW_TEMP
(AND operation with pulse flag);

make blinking tag® 4~ from ALARM_HIGH_TEMP
(AND operation with pulse flag);

make blinking output Q 5.0 from the alarms ALARM_LOW_TEMP and
ALARM_HIGH_TEMP (AND operation with pulse flag);

reference to function FC12:

D network 1
* temperature tags in touchpanel picture ,Temperature Violations*
D network 2
2 changeover text from ,Last Restart* to ,Last Underrun® in touchpanel
picture ,Temperature Violations* D network 3
8 changeover text from ,Last Restart to ,Last Overrun“ in touchpanel D network 4
picture ,Temperature Violations*
4 acknowledgement by means of button ,Acknowledge* in touchpanel D network 5
picture ,Display Temperature® or via pulse at | 0.1
network 6
® blinking tags to display a category temperature violation in touchpanel
pictures ,Display Temperature® and ,Temperature Violations" D network 7

V2.0 07/03/06 17/54



SI E M E N S Application Description

Automation Solution

V20_e.doc

peraturmessung,

Copyright © Siemens AG 2006 All rights reserved

23541638_Tem)|

Application Resistivity Thermometer ID Number: 23541638

2.3 Required hardware and software components

The application was developed and tested with the following components.
Please consider that configuration changes in the sample project are
possibly required in case of deviations from the listed components and that
screen shots in this document can differ from your screen contents.

To realize the sample project, you additionally require:

e PG or PC with corresponding communications processor (e.g. CP5512)
and Microsoft ® Windows 2000 Professional or Windows XP
Professional operating system.

e An MPI cable.

Hardware components

Table 2-3: Hardware components

Component No. | MLFB / Order number Note
SIMATIC S7-300, RAIL 1 6ES7390-1AE80-0AAQ | This is the shortest
L=480MM available rail.
SIMATIC S7-300,LOAD 1 6ES7307-1BA00-0AA0 | Or similar
POWER SUPP. PS 307,

120/230 V AC, 24 V DC,
2A
SIMATIC S7-300, 1 6ES7314-6CF02-0AB0 | The compact version

CPU 314C-2 DP was only used because

COMPAKT of the integrated
DO/DI.

SIMATIC S7, MICRO 1 6ES7953-8LF11-0AA0 | Or larger

MEMORY CARD F. S7-

300/C7/ET 200S IM151

CPU, 3.3V NFLASH, 64

KBYTES

SIMATIC S7-300, FRONT | 2 6ES7392-1AM0O0-0AAQ | Also available with

CONNECTOR 392 WITH

SCREW CONTACTS, 40- spring force terminals

PIN

?:D“Q%ACBTL%EC’\TOFI’DAENEL 1 6AV6545-0BA15-2AX0 | Configurable with

STN-DISPLAY ProTooI/the from

MPI/PROFIBUS-DP version V5.2, SP1 and

INTERFACE WinCC flexible
Compact from version
2004

V2.0 07/03/06 18/54
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Component No. | MLFB / Order number Note
g'/y'éALTE'%g‘OE;FCONN- 1 6XV1830-2AH30 2-wire shielded cable
PROFIBUS, with PROFIBUS
PREASSEMBLED CABLE connectors for
WITH 2 SUB-D- connecting the TP
CONNECTORS 9-POLE, 170A to the CPU.
SWITCHABLE ;
TERMINATING For alternatives see
RESISTORS, 3 M 161.

;gW-PRESSUgi c 1 7MC1006-3DA16 Or equivalent

REW-IN RESISTANCE
THERMOMETER W/O component
R'n%%ﬁuﬁfm(é#/ﬁ 230 Specified type has high
MM PROTECTIVE TUBE tilting lid for picking up
MAT. NO. 1.4571 1 PT100 the measuring
MEAS. RESISTOR IN transducer;
CERAMIC
;'EEGEESAUTNUTRE? 1 7NG3120-0IN0O For installation into
TRANSMITTER SITRANS sensor head (Type B)
TK-L FOR PT100; LOOP of resistivity
POWERED 4-20 MA; thermometer;
PROGRAMMABLE;
WITHOUT GALVANIC
ISOLATION; WITHOUT
EXPLOSION
PROTECTION
MODEM FOR 1 7NG3190-6KB For operation and
SITRANS TK

parameterizing of the
measuring transducer

The resistivity thermometer with integrated measuring transducer is
available under the order number 7MC1006-3DA16-ZK00.

Standard software components
Table 2-4: Standard software components

Component No. | MLFB / Order number Note
EII_'\gAATFII(,i gté;ﬁg@{%ﬁ . 1 6ES7810-4CC08-0YA5 | For order information,
USER, E-SW, SW AND system reql,!lr_e_ments
DOCU. ON CD, LICENSE and compatibility of
KEY ON FD, CLASS A, 5 STEP7 V5.4 see [7].
LANGUAGES (G,E,F,I,S), L
EXECUTABLE UNDER The application runs
WIN2000PROF/XPPROF, also under STEP7,
REFERENCE-HW: S7- V5.3
300/400, C7 e
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Component

No.

MLFB / Order number

Note

WINCC FLEXIBLE 2005

SW,FLOATING LICENSE
LICENSE KEY ON FD SW
AND DOCUMENTATION
ONCD IN
GER/EN/IT/FR/SP, EXEC.
UNDER WIN2000/XPPROF
FOR CONFIGURATION OF
SIMATIC PANELS UPTO
SERIES 170

COMPACT ENGINEERING-

6AV6611-0AA01-1CA5

TP170A requires at
least WIinCC flexible
Compact.

SOFTWARE SIPROM TK
FOR SITRANS TK

7NG3190-8KB

Software for
measuring transducer
configuration

Example files and projects

The following list contains all files and projects used in this example.

Table 2-5: Example files and projects

Component

Note

23541638_Temperaturmessung_V20.zip

This zip file contains the
STEP 7 project

Note Visualization by means of a touch panel is an integrated part of the
STEP7 project. The “temperature measurement” functionality is also met
without visualization.
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2.4

Performance data

Resistivity thermometer
Table 2-6: Data of the PT100-resistivity thermometer 7MC1006-3DA1x

ID Number: 23541638

Criterion

Data / Comment

Design

According to DIN 43765: Screw-in
thermometer

Protective tube

yes

Form

Similar to 2G, DIN 43772; cylindrical, 9
mm (0.35 inch) diameter, wall thickness
1 mm (0.04 inch)

Loading capacity

to 20 bar (290.1 psi) (loading capacity
dependent on material, temperature,
flow rate, mounting length etc., see DIN
43772 for details

Screw socket

GY%; suitable is gasket 21 x 26, similar to
form C or D, DIN 7603

Measuring insert

Replaceable, with measuring insert tube
(6 mm diameter (0.24 inch) made of
stainless steel; terminal block with
clamping springs

Response times (to VDI/VDE 3 522)

e |n water with flow velocity v =0.4
m/s (1.31 ft/s)

e |n air with flow velocity v =1 m/s
(99.97 cm/s)

t0,5 =25s, toygz 75s

t0.5=2min;t0.9=6.3s

Explosion protection

I1'1/2G EEx ia [IC T4/T6

Measuring transducer
Table 2-7: Data of the SITRANS TK-L measuring transducer 7NG3120-0JNOO

Criterion

Data / Comment

Measured variable

Temperature

Sensor type

Pt 100 (DIN IEC 751)

Voltage measurement

Temperature-linear

Type of connection

Two, three or four-wire system

Resolution

14 bit

Input

Measuring accuracy
e Span < 250 °C (450°F)
e Span > 250 °C (450°F)

<0.25°C (0,45°F)
< 0.1% of span

Repeatability

< 0.1°C (0.18°C)

Measuring current

0.3 mA

Measuring cycle

0.7s

V2.0
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Criterion

Data / Comment

Measured range

-200 ... 850°C (-328 ... +1562°F)

Measured span

> 25 °C (45 °F)

Unit °Cor °F

Offset Programmable, max. 10°C (18°F)
Line resistance max. 20 Q/line

Overload capability 35VvDC

Noise rejection 50 and 60 Hz

V20_e.doc

Output signal

4 ...20 mA, 2-wire

Power supply

DC 8 ... 35 V (28 V with Ex)

Underrange/overrange limits

3,5/23 mA (programmable)

peraturmessung,
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- Filter time 0...30s
§- Protection Against reversed polarity
>
@] Resolution 12 bit
Accuracy < 0.1% of span
e Power supply effect < 0.01% of span/V
e Temperature drift typ. 0,003%/°C (0,0016%/°F)
max. 0,01%/°C (0,0056%/°F)
m Ambient temperature -40 ... +85 °C (-40 ... +85.00 °C)
o 5 | Relative humidity < 98%, with condensation
S Rk L
§ S | Electromagnetic compatibility
§ e Interference immunity According to EN 50082-2
e Emitted interference According to EN 50081-1
Weight 50 g (0.11 Ib)
Dimensions see Figure 2-6: Dimensions of the
SITRANS TK-L measuring
c transducer 7NG3120-0JNOO
(@]
8
a) Material Molded plastic

Degree of protection
e Housing
e Terminals

IP40
IPOO

07/03/06
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Figure 2-6: Dimensions of the SITRANS TK-L measuring transducer 7NG3120-0JN0OO

#4073

19 {0.75)

Application software

Table 2-8: Performance data of the application software

Criterion

Performance data

Additional note

Program size

Project:

Project (.zip)
MMC:

RAM: 1318 bytes

15.9 MB
2.96 MB
2636 bytes

For CPU according

Maximum cycle time 4 ms to Table 2-3
Temperature range 10...100°C
Delay of ready status
10s
after restart
Resolution of
temperature display at 2 decimals Unit: °C
the touch panel
Number of HMI screens |3
V20 07/03/06 23/54




SI EM ENS Function Principles and Program Structures

General Function Mechanisms

V20_e.doc

peraturmessung,

Copyright © Siemens AG 2006 All rights reserved

23541638_Tem)|

Application Resistivity Thermometer ID Number: 23541638

Function Principles and Program Structures

Content

This part describes the detailed functions and functional sequences of the
involved hardware and software components, the solution structures and —
where useful — the specific implementation of this application.

It is only required to read this part if you are interested in details on the
solution components and their interaction.

3 General Function Mechanisms

Here you find information on ...

the general function mechanisms which apply with regard to temperature
recordings.

3.1 Possibilities of temperature recordings

Resistivity thermometers or thermocouples are often used for reading a
temperature. These two measuring principles will be described in the
following.

Resistivity thermometer

Figure 3-1: Low-pressure screw-in resistance thermometer

sﬁﬂ“ﬂ%

A resistivity thermometer consists of

e a measuring resistance,
¢ the respectively necessary installation and connection locations.

The measuring resistance changes almost proportionally to the
temperature. Therefore the measured voltage drop is also proportional to
the temperature, when supplied with constant power. The measuring signal
is transmitted through copper cables - according to measuring principle 2-,
3-, or 4-wire measuring — as analog signal either directly or via a measuring
transducer to the following processing electronics.

The measuring resistance is made of platinum (Pt) or nickel (Ni) and
adjusted to 100 Q + 0.12 Q3 at 0°C (therefore the designation Pt100). The
dependency of the resistor from temperature as well as the permitted
deviations are standardized (specified in DIN EN 60 751 (IEC 751)).
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Thermocouple

Figure 3-2: Design of a thermocouple in principle

e Measuring junction

Thermooouple with positive or negative limbs

Connecting point
Compensating leads

Reference junction

Leads

Point at which thermo-e. m. f. is measured

QY

A thermocouple consists of the thermocouple (measuring sensors) and the

respectively necessary installation and connection parts. The thermocouple
is composed of two wires, which are of different metals or metal alloys and

which ends are soldered or welded together.

Because of the different material combinations there are different types of
thermocouples, e.g. K, J, N (for example K stands for the transition
between a nickel-chrome alloy and nickel). Irrespective of the type of the
thermocouple, the measuring principle is the same for all types.

A thermocouple always records a temperature difference, thus for
determining the temperature of the measuring location, the free ends at a
comparison location must always be kept at an equal and known
temperature.

The thermocouples can be extended from their connection point to the
comparison point by means of equalizing wires. The equalizing wires are
made of the same material as the wires of the thermocouple. The feed lines
are made of copper.

The influence of temperature fluctuations at the comparison point can be
compensated by means of an equalizing circuit.
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Property comparison

Table 3-1: Resistivity thermometer and thermocouple in comparison

o [0)
22| 5
g | 3
»Oo | o Note
2 E | E
x2|Q
= | F
Sensitivity © | ®
Accuracy © | ®
Long time stability © ®
Trigger time at temperature
changes ® @
Resist.therm.
- . < approx. 700°C
lity for high
Suitability for high temperatures ® © Thermocouple
> approx. 1800°C
3.2 2-, 3- and 4-line connection at resistivity thermometers

The device (controller, measuring transducer, AL module, electronics...)
processing the temperature signal, usually offers three possibilities to
connect the resistivity thermometer.

2-line connection

Figure 3-3: 2-line connection of a resistivity thermometer

M+
measuring-circuit voltage

M-

— e

current source

lc-

For the measuring signal and the load independent current the same forth
and back lines are used. So the line losses are displayed in the measuring
result.
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3-line connection

Figure 3-4: 3-line connection of a resistivity thermometer

M+
measuring-circuit voltage

- M_

les

current source
ﬁ .

One of the feed lines to the resistivity thermometer is used for both the
measuring signal and the load independent current. So the line losses of
this one feed line are displayed in the measuring result.

4-line connection

Figure 3-5: 4-line connection of a resistivity thermometer

M+
measuring-circuit voltage

o M-

les
current source
ﬁ e

Two separate line pairs are used for the load independent current and the
measuring voltage. So there are hardly any line losses in the almost
currentless measuring lines.

3.3 Connection to the controller

Direct connection

In the S7-300/400 module spectrum there are analog input modules which
operate the measuring types “resistivity thermometer/resistance” and
Temperature® directly. In the respective handbooks /8/ and /9/ you can find
everything on connection types like 2-, 3- and 4-line connection, on
measuring principles and temperature compensation at thermocouples.
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Connection via measuring transducer

Because long feed lines to the measuring sensors are object to loss and
interferences, the direct connection of a temperature sensor to an analog
input module (even with 3 or 4 line connection) is only sensible if the sensor
can be positioned close to the input module. In case of bigger distances
between sensor and analog module a measuring transducer should be
used, which is positioned as close as possible to the temperature sensor
and whose current output (4...20mA) transmits the measuring signal
without interferences to the controller, also over long distances.
Furthermore it is possible -regarding to the S7-300 module spectrum- to
use an AL of the CPU314C-2 DP - as in the given application example-
instead of a separate AL module.

Measuring transducers are available for resistivity thermometers as well as
thermocouples. There are mechanical versions for sensor head installation,
rail mounting and installed into a field housing, for rough industrial use on
the market.

Measuring transducers are usually configured with a configuration software
(see table 2-4).

V20_e.doc

Note Find an overview on the SITRANS T temperature measuring devices in
110/.

You can find details on the measuring transducer, used in this
application, in its operation manual /11/.
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4 Explanations on the Example Program

Here you find information on ...
o how the measured value reaches the controller
e the structure of the STEP7 program

e the functions of the individual blocks and networks.

4.1 Measured value processing

Reading the measuring value

The 4...20 mA signal of the measuring transducer is fed into the controller
at the analog input Al 0 (connection see Table 5-2, point 5). The integrated
A/D converter converts the analog signal into a digital Periphery Input Word
(PIW), which is accessed by the FC12 function. The electrical parameter to
be converted and the PIW address to which the data value is to be filed is
parameterized in HW Config.
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Figure 4-1: HW Config

FIJ%HW Config - [SIMATIC 300 {Configuration) -- AP_TEMP]
E“] Station  Edit  Insert PLC  Wiew Options Window Help

J 0= 2«. @H | én E ||ﬁ ﬁ E |g[ General Addfessesllnputsl Dutputsl

Properties - AI5/AD2 - (RD/52.3) ﬂ

— Input: i
=01 UR
1 BG 307 B Start: IE Process image:
2 CPU 314C-2 DP . I l
End: 761 o5o o
x> Folsl
22 Di240078 ¥ System Default
23 Als02
24 Zahiar
25 Fozitiomiaren - Output
3
4 Start: 752 Process image:
: End 755 [ =
7 ¥ System Default
4
2] v
Cancel Help | '
x|
3
4 Temperature unit; ‘
5
5
7 Input | 0 | 1 | 2 | 3 | 4
g
3 Measurement
10 Measurement type: ||| i IV IV |F|-2L
11
Measuring range: J4.20ma J+10Y  [+-10%  [+~10Y  [600 Ohms
interference frequency lIED Hz B0 Hz IED Hz IED Hz

Cancel | Help |

Figure 4-1 shows, that the measuring range is set to 4...20mA and that the
result of the A/D conversion is transferred to PIW 752. For the PIW
address, the system requirements remain unchanged. The above settings
are part of the application example. You need not change anything in the
hardware configuration.

During A/D conversion the selected measured range (4...20mA) is
projected to a digital value range of 0...27648. For the purpose of
transparent program design, this value range is converted back to a real
number range 4.0 ... 20.0 using the library function “SCALE”, which is
called in FC 12. This will be the starting point for calculating the
temperature.
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Calculating the temperature

Dependency of the temperature from the load-independent current, which the
measuring transducer provides can be depicted as a straight line with
positive inclination. This correlation is illustrated in Figure 4-2.

Figure 4-2: Correlation measuring transducer current — displayed temperature

Tu/°C
100—T— Tmax
excess temperature !
Q5.0 blinking, Q5.2=1
90 4 temp. 8
Q4.6=1 §
80— temp.7 3
(D]
Q4.5=1 S
o =
5 70 /4 temp. 6 9o
G Q44=1 ¢ £
) © S
g— 60— temp. 5 o %
& Q4.3=1 % c
® 50—+ temp.4 oS
g Q42=1 E3
= o 3
5 40— temp.3 N
Q4.1=1 %
30— temp. 2 =
Q4.0=1 g
20— temp. 1 : - —
insufficient temperature !
Q5.0 blinking, Q5.1=1
10—+ | Tmin
I I
' | | |
0 : 5 10 15 20 measuring transducer
| | output current
I I
——— current range A = 16 mA ———»
£ £

The following mathematical equation can be derived from the graphic:

Tm= (IM - Imin) . (Tmax — Tmin) / AI + Tmin];

Twm: measured temperature (°C) [‘PARAMETERS".T]
Iv: output current of the measuring transducer (mA) [# 1]
Imin: min. current value (= 4 mA)

Tmax:  Upper limit of the measuring range
(to be configured at the measuring transducer)
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Thin: lower limit of the measuring range
(to be configured at the measuring transducer)

A current rise of the detecting range (= 16 mA)

4.2 The structure of the STEP7 program
Figure 4-3: Structure of the STEP7 program

OB 100! SFC 20
£
Q
°
>
= FC 12
= B1
g (o) ‘ > < DB 10
(1]
@
o
o

SFC 1 FC 105

organisation blocks
user functions
library functions

system functions

HECE

data blocks

The block architecture of the STEP7 operating system ensures the
structuredness of the program.
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Table 4-1: Used software blocks

Block Explanation

OB1 Organization block (called by the operating system) for the cyclic
program processing. Calls user function FC 12 after the “re-
start_delay_time” has elapsed (see explanation on OB100).

OB 100 Organization block (called by the operating system) which is
processed once during restart of the CPU. This block ensures...

1. by setting the memory bit “trigger_restart_delay”, that after a
restart, the evaluation of the measuring transducer signal is
performed with a delay (10sec). This prevents the software,
when switching on the power supply, from detecting a non-
existent limit temperature violation due to the ready delay of the
sensor and the measuring transducer. The set memory bit
“trigger_restart_delay” starts the “re-start_delay_time” in OB1.

2. that the time stamp of the last restart is displayed in the
respective fields on the “Temperature Violations” screen at the
touch panel until an actual insufficient or excess temperature
occurs.

FC 12 This user function block is the main program of the application. It
contains the following realized features:

e Evaluation of the measuring transducer signal

e Detecting, processing and acknowledging the limit temperature
violations

e Detecting the current temperature sections
e Realizing of the blinking marks.
A detailed description is provided below this table.

DB 10 User data and parameter

FC105 The library function “Scaling Values” (SCALE)from the “TI-S7
Converting Blocks” folder of the Standard Library converts an
integer into a real value, which in physical units is scaled between
bottom and a top limit value. See FC105 online help. In this
application the FC105 scales the analog value which is read in
correspondence with the temperature.

SFC1 System function (implemented in the CPU) for reading the CPU
clock. See SFC1 online help.

SFC 20 System function (implemented in the CPU) for copying a memory
area. In this application, SFC20 is used to transfer the restart time
stamps from the start information of OB100 to the DB10. See
SFC20 online help.

4.3 FC 12 (MAIN) in detail

The detailed description refers to the STEP7 project of which all symbols
and comments were created in English. To provide a clear reference to the
program code, headings, variable names, etc. were not translated in the
following sections.
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The color coding of the networks corresponds with the one in the flowchart
in Figure 2-5.

Table 4-2: Detailed description of FC 12

NW

Explanation

1

Release

A logic 1 at 1 0.0 releases the processing of the block.

Calculating the Temperature

The called function SCALE (FC105) converts the integer value 0...27648
from PEW 752 , which corresponds to the measuring transducer output
current, into a REAL variable 4.0...20.0 (local variable # 1). According to
the relationship

Tm= (IM - Imin) . (Tmax'Tmin)/AI + Thin

the temperature Ty, is calculated. See chapter 4.1.

Detect Limit Violation

e Unconditional resetting of the digital outputs (in AB 4), which
characterize the current level section. This also deletes the level
marks at the touch panel.

e If he current temperature ("PARAMETERS".T) is below temperature 1
(“PARAMETERS”.T comp. [1]), the program goes to jump label “LOW*
in network 5.

e If he current temperature ("“PARAMETERS".T) is above temperature 8
(“PARAMETERS".T comp. [8]), the program goes to jump label “HIGH”
in network 5.

Addressing of temperatures 1 and 8 is performed via pointer.

Detect Range of the Actual Value

e Indicator length A5.1 ("Q_temp_below_MIN") and A5.2
("Q_temp_above MAX") for a limit value violation are reset
automatically.

e The level section in which the current temperature currently moves is
detected. To do this, the current temperature (“PARAMETERS".T) is
compared to the 8 reference temperatures (“PARAMETERS”.T_comp
[n]) one by one until the current section is detected. Digital output Q
4.n (n=0...6) is set accordingly. Addressing of the 8 reference
temperatures is performed in a loop via pointer.
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NW

Explanation

Processing Limit Violation

This network is linked to if a limit temperature violation has been detected
in network 3.

¢ In case of insufficient temperature...

1. the indicator output Q 5.1 ("Q_temp_below_MIN") is set.

2.the ("ALARM_LOW_TEMP") bit representing the blinking mark | =
is set.

3. the display “Last Restart” is switched to display “Last Underrun” in
touch panel screen “Temperature Violations” (resetting
"no_low_temp_violation").

4. time stamp SFC 1 (READ_CLK) is written to DB 10 at the moment
of falling below limit temperature
("PARAMETERS".timestamp_T_low) and so displayed in the touch
panel screen “Temperature Violation“.

¢ In case of excess temperature...

1. the indicator output Q 5.2 ("Q_temp_above MAX") is set.

2.the ("ALARM_HIGH_TEMP") bit representing the blinking mark ' a
is set.

3. the display “Last Restart” is switched to display “Last Overrun” in
touch panel screen “Temperature Violations” (resetting
"no_high_temp_violation").

4. time stamp SFC 1 (READ_CLK) is written to DB 11 at the moment
of exceeding limit temperature
("PARAMETERS".timestamp_T_high) and so displayed in the
touch panel screen “Temperature Violation.
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NW Explanation
6 Acknowledgement

A limit temperature violation displayed at the touch panel by means of
blinking marks "™ 4 and at the controller by means of blinking digital
output Q 5.0, must be acknowledged. The alarms only disappear if alarm
bits "ALARM_LOW_TEMP" or "ALARM_HIGH_TEMP" are reset via input |
0.1 "I_acknowledge" — as far as the temperature is back in the permitted
range.

Pressing the “Acknowledge” button in the touch panel screen “Display
Temperature” has the same function as network 6.

Blinking of Alarm Display

The blinking function of the blinking marks | = a and of output Q 5.0
("Q_toggle_ ALARM") is realized by means of an AND logic connection of
the respective alarm bit with the 1Hz clock memory bit (M 0.5)1 (“blinking”).
The output Q 5.0 blinks at insufficient or excess temperature.

! The clock memory bit is activated and addressed in the CPU Properties in HWConfig.

In order to reach a steady blinking of the blinking marks at the touch panel, a transmission cycle
of 100s was defined for the blinking marks “BLINK_ALARM_LOW" and “BLINK_ALARM_HIGH”
in WIinCC flexible. The other variables are transmitted 1x per hour.
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4.4 The variables at the touch panel

The figure below shows the correlation between the data of the controller
and the HMI screens.

Figure 4-4: Control data in the HMI screens

PARAMETERS. T comp
PARAMETERS. T comp
PARAMETERS. T comp
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5/12/2006 10;09;34 AM  —PARAMETERS.timestemp_T_low (DE10.DBE1Z-19)

Last Overrun

1 .
no_high temp violation (M35.2) (switches text)

S/12/2006 3:38:11 PM  —PLRANETERS.timestawp T high (DE10.DBBZ0-27)

Back
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Structure, Configuration and Operation of the

Application
Content
This part leads you step by step through the structure, important
configuration steps, commissioning and operation of the application.
5 Installation and Commissioning

Here you find information on ...

how you install the hard and software, which configurations and settings
have to be made and which steps are necessary to the commissioning of
the example.

Please follow the descriptions, manuals and delivery information, which are
supplied with the respective products, in any case.

5.1 Parameterizing the SITRANS TK-L measuring transducer

Before installing the hardware components, the SITRANS TK-L measuring
transducer has to be configured. For this reason you need both software
(SIPROM TK, see Table 2-4) and hardware (modem for SITRANS TK, see
Table 2-3).

SIPROM TK is Windows based and is delivered on disc. Install SIPROM
TK on your development system in correspondence with the supplied
operation manual /12/.

Connect the measuring transducer to an available COM interface
(COML1...COM4) of your development system (PG/PC) via the SITRANS
TK modem, according to the following image. There must not be anything
connected to the measuring transducer except of the modem, not even
blind wires.

Figure 5-1: Connection of measuring transducer to PG/PC/...

COM1...COM4

programming device/PC/ ... modem mesuring transducer
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Configure the measuring transducer in accordance with the following table.

Table 5-1: Parameterizing the SITRANS TK-L measuring transducer

No. Instructions Note
5. Start SIPROM TK via “Start > Programs >
Siemens Process Instruments > SIPROM
TK” and select the desired language under
“Language”.
6. Select the available interface under “COM-
port”.
i - i
7. Select SITRANS TK-L under “Products”. B o Lo e
8. Open the editing mask via “Edit > PT100". Il s1PROM TK-L
Archive Edit  Send/Receive Setup Help
] ] (3]
9. Fill out the mask “EDIT data” in accordance with the following image and close the
dialog via “OK”.
x
Input P00 JIEC] Output
Temperature at 4 mA Outside measunng range
Temperature at 20 mA Lower current limit
Damping Upper current limit
Connection Current at senzor breakdown
2-wire
Up-scale
F-wire
Down-scale
4-wire
Alarm value
Sensor correction Product identification
Senszor offzet ‘m b Tag no. FHG3I1Z20-0WNO0
[1].4 Cancel Help
10. | Send the data via “Send/Receive > Send”
to the measuring transducer archive Edit | Send/Receive  Setup Help
-
=
Measure temperature
The transmission process is displayed.
e in SIPROM TK,
V2.0 07/03/06 39/54
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No. Instructions Note
]
Sending data !

e atthe modem
by flashing (green) of the LED.

11. Quit the completed transmission with “OK”. x|
Transmission done |
0K Help

12. | OPTIONAL!

You can save the configuration via “Archive rrdive | Edl Ssrefemle S R

> Save as” or via the button with the disc % @

Symb0| . Print

To open the saved configurations later on, =

go to "Archive > Get"

Archive Edit: Send/Receive Setup Help

[=le]s]fx] MG =R

Only use folders with max. 8 characters
as storage location. The file name
(*.Dat) may also only have a maximum
of 8 characters. As default file name the
first 8 characters of the “Product
identification” entered into the editing
mask (see step5) are entered.

13. Quit the configuration via “Archive > Exit". By doing this you will get back to the
SIPROM TK MENU.

14, Quit SIPROM TK via “Products > Exit".

Note You can find details on the modem and on the software SIPROM TK in
the corresponding operation manual /12/.
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52 Installation of hardware and software

Hardware set up and wiring

Please find the hardware components in the Table 2-3. All components can
be supplied with 24V DC via the PS307 load power unit. For the hardware
configuration, follow the instructions listed in the table below:

Table 5-2: Setup of the hardware

No. Instructions Note

1. On the profile rail arrange the following
hardware components from the left to the
right and screw them down:

Power supply (PS), CPU 314C-2 DP;

2. Screw the front connectors into the two
slots.
3. Bolt together CPU and rack.
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No. Instructions
4, Mount the measuring transducer into the lid
of the connection head at the resistivity
thermometer.
5. Connect the resistivity thermometer to the
analog input Al 0 (left front-plug) of the CPU
via the measuring transducer? . The pin
assignment is printed on the inside of the
cover.
\sensor connecting cable
Connection cable:
e Max. wire diameter 2.5 mm?;
e lay separated from wires with
voltage >60 V;
e use cables with twisted wires;
e use shielded cable if necessary;
See /11/ for details on the measuring
transducer.
6. Wire the power supply (L+, M) for the used
DI/DO part of the CPU (right front plug). The
pin assignment is printed on the inside of
the cover.
7. Connect input 1 0.0 (Release) — if necessary
via a switch —to L+.
8. Connect input | 0.1 (Acknowledge) — if
necessary via a button — to L+.
9. Wire the power supply of the TP170A.

2 In this case, the Pt100 element is connected with three-wire circuit. But because of the
position of the measuring transducer in the vicinity of the Pt100 element the connection type
plays hardly any role.
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No. Instructions Note
10. Use the Profibus cable to connect the MPI Use a plug with PG socket at the CPU
of the S7-CPU to the IF1B interface of the in order to be able to connect your
TP170A. development system (PG, PC) in
addition. The cable from Table 2-3
meets these requirements.
11. Set the DIP switches on the rear of the
TP170A to DP/MPI mode.
12. Connect the MPI of the CPU to the MPI of Plug the MPI cable on the CPU leading
your PG/PC. to the PG/PC in the PG socket of the
PROFIBUS connector.
Note Further information on setting up an S7-300 automation system is

available in /3/.

Installation of the standard software

It is a precondition that the software specified in Table 2-4 is installed on
your PG/PC. If you use a PC or notebook as development system, it is
required that it is equipped with a communications processor (e.g.

CP5512 PC card for notebooks).

5.3 Loading of the application software
Requirements:
1. The hardware installation is completed.
2. All components are supplied with voltage.
3. The CPU is switched to STOP with the mode switch.
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Loading the application software to the CPU

Table 5-3: Loading the application software to the CPU

No. Instructions

Note

1. Set the PG/PC interface.

In the control panel of your
development system, open the “Set
PG/PC Interface” dialog box.

ll"
!I” Set PaJPC Interface

If the interface has already been set, continue
with point 5.

2. Select the following settings:

e Access Point of the Application:
S7ONLINE (STEP7) =
CPxxxx(MPI)

e Interface Parameter Assignment
Used:

CPxxxx(MPI)

Set PG/PC Interface = x|
Access Path |
Aocess Point of the Application;

IS?EINLINE [STEP 7] -» CPEE11[MP] ;I
[Standard for STEP 7]

Interface Parameter &zzignment Lsed:

The CP type depends on the
development system used.

If the above access point is not
included in the list box, create it via

[EPBETI{MPI] <Active>

CPEGT1[4uta]
B CPEGT1(FwL)
B CPSG11(MP)
B CPS611(PPI)

P

- _'ILI

Properties.... |
Diagnostics. . |

Copy... I
Delete |

the <Add/Delete> entry
(also in the “ Access Point of the
Application " list box).

[Parameter azsighmznt of pour
communications proceszar CPEET1 for an
WP network]

application the address “0") and the
other bus parameters as shown in
the figure on the right.

Quit the dialog box with “OK”.

. . Interf
Then click the “Properties...” button. { ristsces
Add/Remave: Select... |
Cancel | Help |
3. Enter the MPI address of the x|
development system (in this - |

— Station Parameters

[~ PG/PC is the only master on the bus

Address: ID _l;
Timeaout: 1s -

r—Metwark, Parameters

Transmiszion Fate:

I'IEIT-".S kbps "I

Highest Station address: A o
ak I D efault | Cancel | Help |

4, Click “OK” to close the “Set PG/PC
Interface” window and exit the
control panel.

5. Open the SIMATIC Manager.
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No. Instructions

Note

6. Extract the project:

1. Select the project
"23541638_ Temperaturmessung
_V20.zip" via the menu “File >
Retrieve...”.

2. Select a target directory for the
extracted project folder.

3. After extracting, you are asked in
the SIMATIC Manager whether
you want to open the project.
Answer with
“Yes”.

The figure on the right shows the

extracted project.

K)SIMATIC Manager - [AP_TEMP -- D= Applikatid
£ Ele Edit Insert PLC Wiew Options Window

ke AR A NG

AEAF TEMP [l SIMATIC 300
[l SIMATIC 300 L Temperature
=@ CPU 314C2DP MPIf]

H-{z5] 57-Program

i Temperature

7. Select the SIMATIC station and load
the project to the S7-CPU via the
“PLC > Download” menu or the
corresponding button.

KSIMATIC Manager - [AP_TEMP - D' Applikatione
£ Fle Edt Insert PLC Wisw Options ‘Window H

D (22| 4 Baefdn|e %%
- hAE ardware
B 1ATIC 300 CEL 314C-2 DP

T OF
H-{z7] 57-Program

-~ Temperature

Load the application software into the panel

Table 5-4: Load the application software into the panel

No. Instructions Note
1. Make sure that the transfer settings
on the TP170A are correct. Click the _
“Config” button in its start menu to [ Enalsasle
display the “Transfer Settings” [] Enable [] Remote
screen form. Make the settings as
shown in the screen shot on the right ‘
and close the dialog box with “OK”. - MPUDP Transfer
[] Enable [ ] Remote
Address 1 Up | Down |
Baudrate | 187.5 kB Up | Down |
oK |

2. In the start menu of the panel —to
which you have now returned — click
the “Transfer” button.

You go to the transfer mode of the panel.
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No.

Instructions

Note

In the development system, open the
WinCC flexible project
“Temperature” via the context menu
(right mouse button) as shown on
the right.

QSIMATIE Manager - [AP_TEMP -- D=4 Applikationen®,...\0Z_|
£ Fle Edit Insert PLC Yiew Options ‘Window Help

D (2w 4 ke %% =)
El% AF_TEMP 5 Screens
E-E SIMATIC 300 = Communication
=L Temperature & Alarm Management
EI R = o st

Open Object ChrlH-al+0

ok el
(ay (W
Baste ChrlY,

Delete Dol

Rename Fz2
Object Properties,.. Alk+Return

Select “Project > Transfer > Transfer
Settings” or click the corresponding
button.

[ wincc flexible 2005 Advanced - AP_TEMP - B

Praject | Edit Wiew Insert Format Faceplates ©

Bl Dend= ok ikl Demiaet Wiz ard

UMD v

Transfer 3 (I'ransfer iettings-]
Recent Projects 3 Backkransfer

ﬂ Exit Backup ...

Meskore ..

g 1]

Make the settings as shown in the screen shot below.

[ef: Select devices for transfer |

2] T ernperature (TP 1704) —Settings for Temperature [TP 1704)

Transfer to
’7(5' Flash = RAM

Mode {MPLIDP

Station address I1

ﬂ Delta transfer
’7 & On i

I | Enablz back harster

¥ | Dwemrite password list

¥ | Evemiite recipe data records

il
(I Tranzfer ” Apply || Cancel

4

Click “Transfer” to start the data transfer.
Answer the question “Do you want to overwrite the existing password list on the
device?” (at least) when transferring your configuration for the first time with “Yes”.

After the end of the transmission, the touch panel will switch to the starting image

(Figure 2-2) set in WinCC flexible.

Note

The above table of steps describes the loading of the TP170A via MPI.

However, the configuration can also be transferred to the panel serially.
For more information please refer to /4/ and /5/.
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5.4 Startup

Requirements:

1. The hardware and software installation as described in chapters 5.1 to
5.3 is completed.

The current temperature is within the permissible range (20...90 °C).

The temperature recording is enabled (1 0.0 = 1).

Table 5-5: Commissioning of the simulation

No. Instructions Response
1. Switch the ... After a delay time of 10 s the touch panel
2. power supply on, shows the following screen. The temperature
3 CPU to RUN. display (values and bars) correspond to the
current conditions.
Display Temperature
. Lask
100
Acknowledge |
10
Define Temp. | German I Stop Runkime
2. Press the “Last Temp. Violation” The time stamp of the last restart is displayed
button to change to the according in the top as well as the bottom half of the

screen. screen.

Temperature Violations

Last Festart
5/12/2006 10:09:34 AM

Last Restart
57122006 10:09:34 AM

Back
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No.

Instructions

Response

Press the “Back” button to return

to the temperature display.

Press the “Define Temp” button

to change to the according
screen.

temperature.

The level mark is in the section of the current

Define Temperatures

Temperature § [ 2]
Temperature 7 [ 2]
Temperature & [ 2]
Temperature 5[]
Temperature 4 [ 2]
Temperature 3 [ ]
Temperature 2 [ 2]
Temperature 1 [ 2]

. Back

+490.00
+i0.00
+70.00
+60.00
+50.00
+40.00
+30.00
+20.00

{upper limit)

1

(lonser limit)

Change the actual temperature:
20°C < actual temperature <90°C

Value and bar are correctly displayed in the
“Display Temperature” view. The level mark in
the “Define Temperatures” view always jumps
to the current temperature section.
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No. Instructions Response

5. Reduce the actual temperature to
< 20°C.

This gives you the following screen contents:

Display Temperature

Temperature [2C]: [+14,00 Last

Termp. Yiolation

104a

Acknowledge

. = — blinking

Define Temp. | Stop Runtime

Temperature Violations

Last Linderrun

5/12/2006 10:21:18 AM

Last Restart
57122006 10:09:34 AM

Define Temperatures

Temperature 8 [9C]  |+o0.00 {upper limit)

Temperature 7 [ 9]
Temperature 6 [ 9]
Temperature 5 [ 9]
Temperature 4 [ 2]
Temperature 3 [ 9]
Temperature 2 [ 9]

Temperature 1 [ 9]

+ia0,00
+70.00
+60,00
+50,00
+40.00
+30.00

+20.00 (lowaer linnit)

w

~ blinking

V2.0

07/03/06

49/54




SI E M E NS Structure, Configuration and Operation of the Application

Installation and Commissioning

V20_e.doc

peraturmessung

Copyright © Siemens AG 2006 All rights reserved

23541638_Tem)|

Application Resistivity Thermometer ID Number: 23541638
No. Instructions Response
6. Increase the actual temperature to This gives you the following screen contents:
>90°C.
Display Temperature
. Last
Ul e LV RS Temp.?-'isolation |
100
4 — blinking
Acknowledge |
. w9 — blinking
Define Temp. | Ferman | Stop Runtire

Temperature Violations

Last Underrun

5/12/2006 10:21:18 AM

Last Crwverrun

5/12/2006 10:44:53 AM

Back

Define Temperatures
. blinking

-~
Temperature &[] 490,00 {upper limit)
Temperature 7 [9C] [+20.00

Temperature 6 [9C]  [+70.00

Temperature 5[] 460,00

Temperature 4 [*C] (450,00

Temperature 3[9C]  [+40.00

Temperature 2 [9C]  [+30.00

Temperature 1 [ 2C]  |420.00 (lovaer limit)

.
blinking

7. Bring the temperature back to the The blinking marks in the “Display

permitted range and acknowledge Temperature” and “Define Temperatures”
the temperature violation with the screens disappear. The contents of the
“Acknowledge” button in the “Display | “Temperature Violations” screen remain
Temperature” screen. unchanged.
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No. Instructions Response
8. Select the “Define Temperatures” A key pad for value input appears.
screen and change, for example, the
temperature 4 to 45°C by touching 45.00)]
the respective I/O box.
A 1 i 3 ESC
B 4 5 6 B5SP
C ¥ 8 9 +]-
D E F 0
Complete your entry with o
9. Vary the actual temperature in the The temperature display (level mark in the
30...50°C range. “Define Temperatures” screen) corresponds
with the changed temperature range limit.
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6 Literature
6.1 References on hardware and software of this application

This list includes documents/entries referred to in this application.

Table 6-1: References on hardware and software of this application

Title

/1/ | Siemens A&D Customer Support
http://www.ad.siemens.de/support

/2] | Reference to this entry
http://support.automation.siemens.com/WW/view/en/23541638

/3/ | Operating Instructions
S7-300, CPU 31xC and CPU 31x: Installation

http://support.automation.siemens.com/WW/view/en/13008499

/4/ | Operating Instructions
TP 170micro, TP 170A, TP 170B, OP 170B (WinCC flexible)

http://support.automation.siemens.com/WW/view/en/19082123

/5/ | User's manual
WinCC flexible 2005 Compact / Standard / Advanced

http://support.automation.siemens.com/WW/view/en/18796010

16/ FAQ 1070096
Which connectors and cables do | need to connect an OP/PG to an
S7-controller? Is there a standard cable?

http://support.automation.siemens.com/WW/view/en/1070096

17/ FAQ 22445076
Information on STEP7 V5.4

http://support.automation.siemens.com/WW/view/en/22445076

/8/ | Automation system S7-300 module data
Reference manual
http://support.automation.siemens.com/WW/view/en/8859629

/9/ | Automation systems S7-400, M7-400 module data
Reference manual
http://support.automation.siemens.com/WW/view/en/19539653

/10/ | Product overview SITRANS T temperature measuring devices

http://pia.khe.siemens.com/efiles/feldg/files/kataloge/fi0l ge/sitranst prod
uktuebersicht fi0lge.pdf

/11/ | Operation manual for SITRANS TK-L measuring transducer
http://support.automation.siemens.com/WW/view/en/7306608

/12/ | Operation manual for the modem for SITRANS TK and for the
SIPROM TK software

http://support.automation.siemens.com/WW/view/en/13973961
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http://support.automation.siemens.com/WW/view/en/21523291
http://support.automation.siemens.com/WW/view/en/21523291
http://support.automation.siemens.com/WW/view/en/21523291
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6.2 Further literature

This list is by no means exhaustive and only gives a selection of
appropriate sources.

Table 6-2: Further literature

Title

/13/ | Hans Berger
Automating with STEP7 in STL and SCL
Publicis Corporate Publishing ISBN 3-89578-242-4

Book presentation:
http://books.publicis-
erlangen.de/de/produkte/techinhan/auto/index.cfim?bookid=5816

/14/ | Elmar Schrifer

Elektrische Messtechnik [Electrical Measurement Techniques]
HANSER technical book 2004

Fachbuchverlag Leipzig ISBN 3-44621-809-2
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7 History
Table 7-1 History
Version Data Modification
V1.0 07/23/02 First edition (BID 12372960)
V2.0 07/03/06 Complete revision
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